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Success4 Instructions 
This information package contains everything you will need to begin organizing kids, families, and your community for 

a Success4 initiative in your area. All of the enclosed materials have been professionally produced and are approved for 
your use. We ask only that you follow these instructions and recommendations to maintain the integrity of the initiative and 
to achieve maximum possible effectiveness. 

Success4 Video 
Always begin your presentation with the Success4 Video. This video presentation provides a broad overview 

of the Success4 School Improvement Process and gives prospective participants a general understanding of the principles 
and practices involved in the Success4 process. In this information package, you will find the Success4 Video Cassette. 

Success4 Overhead Presentation 
After giving your audience a general understanding of the Success4 process with the video presentation, you may 

wish to cover some points more comprehensively. For this purpose, the same information, plus parameters for local goal 
setting, is available to you in a format suitable for overhead projection. This technique will allow you to spend more time 
on specific points and answer audience questions more thoroughly than generally is possible during the video presentation. 
A printed script is provided as a guide to the overhead presentation. You may wish to familiarize yourself with the 
script before delivering the overhead presentation. 

Success4 Mac & PC PowerPoint Presentation 
PowerPoint is a computer program that combines the interest and appeal of limited animation with the control of a 

"slide show". Visuals remain unchanged on the screen until you affect the change. Visuals change in sequence, and graphics 
zoom in and out of the on-screen image at the touch of your mouse button. The effect is very alluring and attention getting, 
without sacrificing the ability to cover specific points as comprehensively as you wish. Some rehearsal is recommended. 
The Success4 PowerPoint presentation is provided in both MAC and PC formats for your convenience. It is ideal for 
1-on-1 presentations or even for use with groups of 3 to 4 people. Or, you can project the PowerPoint presentation for 
larger audiences. (See back for more information.) 

Success4 Brochure 
This brochure is an excellent leave-behind to remind viewers of the important facts from your video, PowerPoint or 

overhead presentation. Undoubtedly, you will encounter situations in which video, overhead, and PowerPoint presentations 
are not possible and might be inappropriate. A leave-behind brochure is the perfect medium for your message in these 
circumstances. The Success4 brochure is executed in beautiful 4-color photography and tells the entire Success4 story. 
Use it with busy executives or anywhere that time and circumstance do not allow video, overhead, or PowerPoint presentations. 
A small supply of Success4 brochures is provided in your information package, and you may order more by contacting the 
Iowa Department of Education. 

Success4 Model 
The Success4 Operational Model offers a complete and colorful explanation of the new school improvement program at 

a glance. Use it to enhance any Success4 presentation or even when you need just a quick explanation of the program. It's 
bright, attractive, and easy to understand and remember. A 4-color copy of the model is provided in the information package, 
along with black & white digital art suitable for reproduction. 

Success4 Logo 
This attractive , professionally designed art identifies printed material as part of the Success4 program. You may feel free 

to use it on any official correspondence and materials used in the program. A black and white logo sheet is provided for your 
convenience. Three-color, and black & white, digital logo art also is included in this information package for use on printed 
materials . Just supply the enclosed diskette to your local printer. 

Success4 Logo Application Brochure 
We encourage you to use the Success4 logo whenever and wherever appropriate. In fact, we have a few suggestions for 

you, just to get the ball rolling . Take a look inside this handy little brochure for some ideas on how you can make the most of 
the Success4 logo. 

Success4 News Releases 
From time to time, you may want to publicize your Success4 activities in order to inform the public, generate awareness, 

or spark new interest. The sample news releases contained in your information package will serve as convenient models for 
anyone not familiar with the_general format and tone of this vehicle. News Releases never guarantee publication, but they do 
offer a convenient way to keep busy news editors up to the minute on your Success4 efforts. 

DON'T FORGET TO RETRIEVE ANY SUCCESS4 MATERIALS YOU MAY HAVE PROVIDED TO PRINTERS AND OTHER 
SUPPLIERS FOR PRODUCTION PURPOSES. SUPPLIES ARE LIMITED, AND REPLACEMENT MATERIALS MAY NOT 
BE AVAILABLE FOR SUBSEQUENT USE. 

Iowa Department of Education • 1998 
Grimes State Office Building• Des Moines, Iowa 50319 • (515)281-3176 



Instructions for PC PowerPoint Presentation 

In Windows 3.1 or lower. 

1. Place the diskette in your A drive and double-click your mouse on the File Manager icon. 

2. In the File menu, use the Create Directory, to make a Success4 directory. 

3. In the Window menu select New Window. 
(Note: If there are already 2 windows , skip to 5.) 

4. In the Window menu select Tile. 

5. Now, click on A: in the new window to switch to your A drive and drag the 
PowerPoint show or Success4 overheads file to your new Success4 directory . 
. 

6. Double-click,.on the PowerPoint file to start the program. 

7. Then, use the Open command under the File menu to open the Success4 file. 

In Windows 95. 

1. Place the diskette in your A drive and double-click the My Computer icon on your desktop. 

2. Open your C drive. 

3. In the File menu select New/ Folder and name Success4. 

4. Double-click your A drive and drag the PowerPoint show or Success4 overheads file to the Success4 folder. 

5. Double-click on the PowerPoint file to start the p•ogram, and run the file. 

Instructions for MAC PowerPoint Presentation 

1. At the desktop, use the New Folder command in the File menu to create a new folder. 

2. Name this new folder Success4. 

3. Place the diskette in the floppy drive and double-click on the disk icon to open the disk. 

4. Next drag the PowerPoint file icon to the new Success4 folder. 

5. To run the Success4 presentation, double-click on the folder icon, then double-click 
on the PowerPoint file . 

Instructions for printing overheads 

1. To print your own black and white overheads, place the overhead diskette in the A drive. 

2. Open the diskette and the PowerPoint program as you normally would . 

3. Use the Open command in the File menu to open the Success4 overhead file 
and follow the instructions in the dialog box. 

Important: Your laser printer must be loaded with overhead blanks designed for 
laser printers. Standard overhead blanks will melt in a laser printer. 
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PowerPoint® Presentation Script 

1■: 

To anyone with eyes to see, it is obvious that today's 
children lack many of the social, emotional, 
intellectual and behavioral skills that we adults take for 
granted. That much is evident all around us ... drugs, 
violence, crime, relationship problems .. .learning 
problems. Until recently, our inability to address these 
issues and affect any real change made the situation all the 
more frustrating. But now, there is a new process 
that helps us work together and make things better for 
children in all aspects of life. It's called Success4. 

Success4 focuses on the social, emotional, intellectual and 
behavioral development of students ... 

. . . and calls for involvement on four levels: kids, families, 
schools and communities. 

It is expected that when kids, families, schools and 
communities focus on development in these four areas, 
we will attain healthy and safe learning communities. 

The Iowa Department of Education in, "Education is 
Iowa's Future: The State Plan for Educational Excellence 
in the 21st Century," identifies the following education 
system goal: 
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To improve the level of learning, achievement and 
performance of all students so they will become successful 
members of their community and the work force. 
Three support goals for this education system goal are also 
identified within the DE strategic plan. Strategies are then 
identified for each of the support goals. 

For instance, Support Goal B in the Department of 
Education Strategic Plan is: to coordinate the educational 
support system so it is focused on helping schools and 
communities meet their local goals. Strategies are 
identified to achieve this support goal. 

All Success4 activities are linked to this strategy. 

Leadership of Success4 at the state level includes 
professionals committed to school improvement who 
contribute expertise in programs for students at-risk, 
community education, service-learning, school 
improvement. . . 

special education, early childhood, school-to-work, and 
safe and drug-free schools and communities. 
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This kind of collaboration is also taking place at the AEA 
and LEA levels through the development of cross
divisional teams and the joint development of district 
school improvement plans and AEA accreditation plans. 

The definitions of social, emotional, behavioral and 
intellectual development presented here are intended to 
clarify the meaning of these terms when used in Success4. 

Social Development is the process of establishing 
satisfying, reciprocal relationships and interactions with 
others. 

Emotional Development concerns the acquisition of 
positive attitudes, values and feelings in children and 
youth. 

Intellectual Development is the process of acquiring 
integrated thinking skills that impact social, emotional 
and behavioral development and academic achievement. 

Intellectual development is an important addition to 
Success4, because it is critical in determining academic 
achievement along with healthy social, emotional and 
behavioral development. 

3 



Behavioral Development is the individual's ability to 
display appropriate behavior. 

Vision, Mission, and Beliefs comprise the guiding ideas 
on which an organization is built. They should be shared 
by all members of the organization and key stakeholders 
from diverse groups and able to be understood by others 
outside of the organization. In combination, the guiding 
ideas give meaning and direction to the actions of the 
people and form to the organization. They are the central 
linking force for motivating all members of the 
organization to personal and collective action in pursuit 
of their fulfillment. 

These ideas focus people's attention on what is important; 
provide clarity, direction and driving power for change; 
increase the sense of shared responsibility for student 
performance and success; and serve as a framework for 
decision-making. Following are the Vision, Mission, and 
Beliefs developed by the Success4 Core Committee. You 
may adopt them for your own use, or you may develop 
new statements that more accurately describe your own 
circumstances and needs. 

The Success4 Vision is: All Iowa children and youth will 
experience success throughout life. 

Our Mission states that Iowa needs to become a place 
where schools, families and communities work together 
to support the social, emotional, intellectual and 
behavioral development of all children and youth. 
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And Success4 is based on four beliefs. Belief number one 
states that social, emotional, intellectual and behavioral 
skills are essential to success in school and throughout 
life. 

Belief number two is that all children and youth can be 
successful socially, emotionally, intellectually and 
behaviorally. 

Belief number three is that families, schools, and the 
community must work together in partnership to ensure 
the social, emotional, intellectual and behavioral well
being of children and youth. 

And finally, Success4 is based on the belief that changing 
the family-school-community relationship is necessary in 
order to create an environment which nurtures social, 
emotional, intellectual and behavioral development for 
all children and youth. 

In addition to the Vision, Mission, and Beliefs, the Iowa 
Department of Education has identified four parameters 
that school districts are asked to use to guide their goal 
setting efforts. Each parameter corresponds to one of the 
four identified targets of Success4--kids, families, schools 
and communities. 
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Parameter 1: Skill development in the four areas of social, 
emotional, intellectual and behavioral development is 
essential to student success. A goal that a school district 
might identify in this area could be: 

Students will develop problem-solving skills that are 
essential to resolving interpersonal conflicts. (Conflict 
Management). 

Parameter 2: Families and schools must work in 
partnership in order to best support their youth. A goal 
that a school district might identify in this area could be: 

A system of family-school communication that addresses 
the diverse needs of families will be developed 
collaboratively by families and the school. 

Parameter 3: School personnel must have the training 
and resources necessary to support and enhance the social, 
emotional, intellectual and behavioral development of 
youth. A goal that a school district might identify in this 
area could be: 

District staff development programs will target needs in 
the areas of social, emotional, behavioral and intellectual 
development. 

Parameter 4: Community partnerships are essential to 
creating better responses to social, emotional, intellectual 
and behavioral needs. A goal that a school district might 
identify in this area could be: 

Identify partnerships with key organizations and 
individuals that support social, emotional, intellectual 
and behavioral development. 

Here is a standard planning model. It is sometimes 
difficult for organizations to make their way around the 
full circle. Many organizations fail in the evaluation and 
re-assessment. Success4 is designed to help local schools 
and their community partners complete that circle, 
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continuing to improve and refine their services to 
children, youth, and families . 

Success4 provides a framework for the assessment process. 
It gives the local school-community partnership options 
that help them meet needs and achieve results they 
identify during their assessment phase. This selection of 
the best practices for specific needs constitutes the core of 
the planning process. 

Once the needs have been determined, a plan should be 
established to satisfy those needs. Planning will help you 
avoid distractions and keep the process moving forward 
in logical order. Planning also gives others a chance to 
contribute to the process and, perhaps, offer options that 
are based on sound research. 

As the local partnership moves into the implementation 
phase, it is important that they have appropriate tools, 
resources, skills, and expertise to effectively implement 
the changes they are planning. Again, Success4 is designed 
to provide those supports. 

As implementation proceeds, Success4 provides the 
support and technical assistance that allows the local 
school-community partnership to refine, expand, and 
generally improve its efforts, and continue to improve its 
delivery system. 

Evaluating methods and procedures makes it possible to 
refine the Success4 process. It allows you to retain those 
tools and techniques that work and discard those that do 
not work. Over time, the Success4 process will become 
more and more efficient and productive. It will enable 
local schools to make a real difference in the lives of their 
students. 
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The Operational Model is intended to demonstrate a 
dynamic, ever-changing, always-learning system which 
grows and builds on its own experience to provide ever
improving information and services to the children, 
families, and communities that ultimately benefit from 
the Success4 process. 

Obviously, this is not a linear process. Many activities and 
interventions may be taking place at once, the 
interventions may occur in a different order, and special 
conditions may emerge which require immediate, out-of
sequence responses. 

The local school-community partnership is in the best 
position to know and understand its own needs. At the 
same time, a broader perspective, special expertise and 
access to information, services, and resources can 
reinforce and enhance that effort. 

It is the role of the Area Education Agency, consulting 
with the local partnership, to provide that support and 
technical assistance. 

The state's role is to provide similar support to the Area 
Education Agencies. The state can ensure that current 
research, appropriate resources, and shared opportunities 
fully equip the Area Education Agencies to provide 
appropriate support to the local school-community 
partnerships. 

The two-way arrows demonstrate that this is not a one
way process. Learning takes place at all levels at all times. 
While local partnerships are learning from the AEAs, the 
AEAs are learning from them and sharing that 
information throughout their area. At the same time, the 
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state is learning from the experience of the AEAs and 
sharing that knowledge throughout the state. 

From your experience with the Operational Model, it 
should be easy to see that Success4 is a dynamic, 
interactive, and collaborative process. It is an adaptive 
program that changes to meet the varying needs of the 
people who use it. That makes Success4 unique, ideal for 
families, schools, and communities in the state of Iowa, 
who put such high value on the quality of education and 
whose commitment to education is unsurpassed 
anywhere. 

If you would like more information about Success4, please 
consult the accompanying literature or contact the Iowa 
Department of Education for our free video: 
1-515-281-3176. 

9 



Overhead Presentation Script 

To anyone with eyes to see, it is obvious that today's 
children lack many of the social, emotional, 
intellectual and behavioral skills that we adults take for 
granted. That much is evident all around us ... drugs, 
violence, crime, relationship problems .. .learning 
problems. Until recently, our inability to address these 
issues and affect any real change made the situation all the 
more frustrating. But now, there is a new process 
that helps us work together and make things better for 
children in all aspects of life. It's called Success4. 

Success4 focuses on the social, emotional, intellectual and 
behavioral development of students .... and calls for 
involvement on four levels: kids, families, schools and 
communities. 

It is expected that when kids, families, schools and 
communities focus on development in these four areas, 
we will attain healthy and safe learning communities. 

The Iowa Department of Education in, "Education is 
Iowa's Future: The State Plan for Educational Excellence 
in the 21st Century," identifies the following education 
system goal: 

To improve the level of learning, achievement and 
performance of all students so they will become successful 
members of their community and the work force. Three 
support goals for this education system goal are also 
identified within the DE strategic plan. Strategies are then 
identified for each of the support goals. 
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For instance, Support Goal B in the Department of 
Education Strategic Plan is: to coordinate the educational 
support system so it is focused on helping schools and 
communities meet their local goals. Strategies are 
identified to achieve this support goal. 

All Success4 activities are linked to this strategy. 

Leadership of Success4 at the state level includes 
professionals committed to school improvement who 
contribute expertise in programs for students at-risk, 
community education, service-learning, school 
improvement ... 

special education, early childhood, school-to-work, and 
safe and drug-free schools and communities. 

This kind of collaboration is also taking place at the AEA 
and LEA levels through the development of cross
divisional teams and the joint development of district 
school improvement plans and AEA accreditation plans. 

The definitions of social, emotional, behavioral and 
intellectual development presented here are intended to 
clarify the meaning of these terms when used in Success4. 

Social Development is the process of establishing 
satisfying, reciprocal relationships and interactions with 
others. 
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Emotional Development concerns the acquisition of 
positive attitudes, values and feelings in children and 
youth. 

Intellectual Development is the process of acquiring 
integrated thinking skills that impact social, emotional 
and behavioral development and academic achievement. 
Intellectual development is an important addition to 
Success4, because it is critical in determining academic 
achievement along with healthy social, emotional and 
behavioral development. 

Behavioral Development is the individual's ability to 
display appropriate behavior. 

Vision, mission, and beliefs comprise the guiding ideas on 
which an organization is built. They should be shared by 
all members of the organization and key stakeholders 
from diverse groups are able to be understood by others 
outside of the organization. In combination, the guiding 
ideas give meaning and direction to the actions of the 
people and form to the organization. They are the central 
linking force for motivating all members of the 
organization to personal and collective action in pursuit 
of their fulfillment. 

These ideas focus people's attention on what is important; 
provide clarity, direction and driving power for change; 
increase the sense of shared responsibility for student 
performance and success; and serve as a framework for 
decision-making. Following are the Vision, Mission, and 
Beliefs developed by the Success4 Core Committee. You 
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may adopt them for your own use, or you may develop 
new statements that more accurately describe your own 
circumstances and needs. 

The Success4 Vision is: All Iowa children and youth will 
experience success throughout life. 

Our Mission states that Iowa needs to become a place 
where schools, families and communities work together 
to support the social, emotional, intellectual and 
behavioral development of all children and youth. 

And Success4 is based on four beliefs. Belief number one 
states that social, emotional, intellectual and behavioral 
skills are essential to success in school and throughout 
life. 

Belief number two is that all children and youth can be 
successful socially, emotionally, intellectually and 
behaviorally. 

Belief number three is that families, schools, and the 
community must work together in partnership to ensure 
the social, emotional, intellectual and behavioral well
being of children and youth. 
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And finally, Success4 is based on the belief that changing 
the family-school-community relationship is necessary in 
order to create an environment which nurtures social, 
emotional, intellectual and behavioral development for 
all children and youth. 

In addition to the Vision, Mission, and Beliefs; the Iowa 
Department of Education has identified four parameters 
that school districts are asked to use to guide their goal 
setting efforts. Each parameter corresponds to one of the 
four identified targets of Success4--kids, families, schools 
and communities. 

Parameter 1: Skill development in the four areas of social, 
emotional, intellectual and behavioral development is 
essential to student success. A goal that a school district 
might identify in this area could be: 

Students will develop problem-solving skills that are 
essential to resolving interpersonal conflicts. (Conflict 
Management). 

Parameter 2: Families and schools must work in 
partnership in order to best support their youth. A goal 
that a school district might identify in this area could be: 

A system of family-school communication that addresses 
the diverse needs of families will be developed 
collaboratively by families and the school. 

Parameter 3: School personnel must have the training 
and resources necessary to support and enhance the social, 
emotional, intellectual and behavioral development of 
youth. A goal that a school district might identify in this 
area could be: 

District staff development programs will target needs in 
the areas of social, emotional, behavioral and intellectual 
development. 
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Parameter 4: Community partnerships are essential to 
creating better responses to social, emotional, intellectual 
and behavioral needs. A goal that a school district might 
identify in this area could be: 

Identify partnerships with key organizations and 
individuals that support social, emotional, intellectual 
and behavioral development. 

Here is a standard planning model. It is sometimes 
difficult for organizations to make their way around the 
full circle. Many organizations fail in the evaluation and 
re-assessment. Success4 is designed to help local schools 
and their community partners complete that circle, 
continuing to improve and refine their services to 
children, youth, and families. 

Success4 provides a framework for the assessment process. 
With best practices, Success4 gives the local school
community partnership options that help them meet 
needs and achieve results they identify during their 
assessment phase. This selection of the best practices for 
specific needs consititutes the core of the planning process. 

As the local partnership moves into the implementation 
phase, it is important that they have appropriate tools, 
resources, skills, and expertise to effectively implement 
the changes they are planning. Again, Success4 is designed 
to provide those supports. 

As implementation proceeds, Success4 provides the 
support and technical assistance that allows the local 
school-community partnership to refine, expand, and 
generally improve its efforts, and continue to improve its 
delivery system. 

The Operational Model is intended to demonstrate a 
dynamic, ever-changing, always-learning system which 
grows and builds on its own experience to provide ever
improving information and services to the children, 
families, and communities that ultimately benefit from 
the Success4 process. 
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Although this appears to be a linear process, it is not. 
Many activities and interventions may be taking place at 
once. The interventions may occur in a different order, 
and special conditions may emerge which require 
immediate, out-of-sequence responses. 

The local school-community partnership is in the best 
position to know and understand its own needs. At the 
same time, a broader perspective, special expertise and 
access to information, services, and resources can 
reinforce and enhance that effort. It is the role of the Area 
Education Agency, consulting with the local partnership, 
to provide that support and technical assistance. 

The state's role is to provide similar support to the Area 
Education Agencies. The state can ensure that current 
research, appropriate resources, and shared opportunities 
fully equip the area education agencies to provide 
appropriate support to the local school-community 
partnerships. 

The two-way arrows indicate that this is not a one-way 
process. Learning takes place at all levels at all times. 
While local partnerships are learning from the AEAs, the 
AEAs are learning from them and sharing that 
information throughout their area. At the same time, the 
state is learning from the experience of the AEAs and 
sharing that knowledge throughout the state. 

From your experience with the Operational Model, it 
should be easy to see that Success4 is a dynamic, 
interactive, and collaborative process. It is an adaptive 
program that changes to meet the varying needs of the 
people who use it. That makes Success4 unique, ideal for 
families, schools, and communities in the state of Iowa, 
who put such high value on the quality of education and 
whose commitment to education is unsurpassed 
anywhere. 
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If you would like more information about Success4, please 
consult the accompanying literature or contact the Iowa 
Department of Education for our free video: 
1-515-281-3176. 
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Iowa Department of Education 

Strategy 
Advocate for Community 

Partnerships and Linkages 

• Schools 
• Parents 
• Community Members 
• Businesses · 
.• Institutions 
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Programs ... 

• Student At-Risk • Special Education 
• Community Ed • Early Childhood 
• Service Learning • School-to-Work 
• School Improvement • Safe and Drug-Free 
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AEA&LEA 
collaboration 

Cross-Divisional Teams 
Joint Development . 
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Social 
Development 

... is the process of 
establishing satisfying, 
reciprocal relationships 

-and interactions with others. 
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Emotional 

Development 
... concerns the acquisition 

of positive attitudes, 
values and feelings in 
·children and youth. 



~ • F~ • Sd,t,~li- • c~~ 
r: 

5"c:..d•~w~•/~•~~'1Al 

Intellectual 
Development 

... is the process of acquiring 
integrated thinking skills 

, that impact social, emotional 
-and behavioral development 

8 and academic achievement. 
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Behavioral 
Development 

... is the individual's 
ability to display · 

appropriate behavior . 
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VISION 
All Iowa children and youth 

will experience success 
throughout life. · 
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MISSION 
That Iowa needs to become a 
place where schools, families 

and communities work together 
_ to support the social, emotional, 
, intellectual and behavioral 

development of all children 
12 - and youth. 
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Belief #1 
Social, emotional, intellectual 

and behavioral skills are 
essential to success in school 

and throughout life. · 
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Belief#2 
All children and youth can be 

successful socially, emotionally, 
intellectually and behaviorally. 
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Belief #3 
Families, schools and the 

community must work together 
in partnership to ensure the 

_ social, emotional, intellectual 
, and behavioral well-being of 

. . 

_ children and youth. 
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Belief #4 
Changing the family-school

community relationship is 
necessary in order to create 

, an environment which nurtures 
, social, emotional, intellectual . . 

and behavioral development. 
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KIDS 
Parameters For Local Goal Setting 

Parameter #1 
Skill development in the four 

areas of social, emotional, 
intellectual and behavioral 
development is essential to . 

student success. 
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FAMILIES 
Parameters For Local Goal Setting 

Parameter #2 
Families and schools must 

work in partnership in order 
to best support 
their youth. 



SCHOOLS 
Parameters For Local Goal Setting 

Parameter #3 
School personnel must have the 
training and resources necessary 

to support and enhance the social, 
- emotional, intellectual and behavioral 
, . development of youth. 
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COMMUNITIES 
Parameters For Local Goal Setting 

Parameter #4 
Community partnerships are 

essential to creating better responses 
to social, emotional, intellectual and 

behavioral needs. 
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Logo Applications 



PMS stands for Pantone Matching System. 
It provides formulas for 1,000 Pantone colors 
and assures that your printer has the same color 
selection that you do. When printing color images, 
provide the PMS color codes to you printer or the 
CMYK 4-color process equivalents given below. 

PMS 342 Green 1 OOC/ OM/ 69Y / 43K 

PMS 207 Red OC/100M/43Y/18.5K 

PMS 109 Yellow OC/8.5M/ 94Y/OK 

PMS 288 Blue 100C / 65M /OY/ 30.5K 

PANTONE PMS 288 

PANTONE PMS 207 

PANTONE PMS 207 

PANTONE PMS 109 

---- PANTONE PMS 288 

BLACK (!00%) 
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NEWS RELEASE 

FOR IMMEDIATE RELEASE: 

SCHOOL BOARD ADOPTS 
NEW Success4 INITIATIVE. 

(CITY /COUNTY NAME), IA--The (CITY /COUNTY NAME) School Board today 

announced the adoption of the new Success4 integrated initiative for school 

improvement. The decision came following a unanimous vote earlier this week. 

According to Board Chair-person, (BOARD MEMBER NAME), the mission of the 

Success4 school improvement initiative is to make Iowa a place where schools, 

families and communities work together to support the social, emotional, 

intellectual and behavioral development of all children and youth. 

Success4 is based on four beliefs: 1. that social, emotional, intellectual and 

behavioral skills are essential to success in school and throughout life; 2. that all 

children and youth can be successful socially, emotionally, intellectually and 

behaviorally; 3. that families, schools, and the community must work together in 

partnership to ensure the social, emotional, intellectual and behavioral well-being 

of children and youth; and, 4. that changing the family-school-community 

relationship is necessary in order to create an environment which nurtures social, 

emotional, intellectual and behavioral development for all children and youth. 
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Success4 is based on four beliefs: 1. that social, emotional, intellectual and 

behavioral skills are essential to success in school and throughout life; 2. that all 

children and youth can be successful socially, emotionally, intellectually and 

behaviorally; 3. that families, schools, and the community must work together in 

pai;tnership to ensure the social, emotional, intellectual and behavioral well-being 

of children and youth; and, 4. that changing the family-school-community 

relationship is necessary in order to create an environment which nurtures social, 

emotional, intellectual and behavioral development for all children and youth. 

(BOARD MEMBER NAME) went on to explain, "This is the first time that the 

combined resources of such diverse groups as families, schools, communities, and 

the State of Iowa have been brought to bear on the problems and needs of 

individual schools. We start by assessing the needs of the families, local schools, and 

community. Then we develop a plan to meet those needs, implement the plan, and 

evaluate our efforts. It is a very efficient, very effective process. We believe it will go 

a long way in producing better educated students who are emotionally well adapted 

and have the social skills to cope in today's complex society." 

If you would like more information about the Success4 School Improvement 

Initiative and how you can become involved, contact (BOARD MEMBER NAME) at 

(LOCAL PHONE NUMBER). If you would like to organize a Success4 initiative in 

your own community, contact your Area Education Agency or the Iowa Department 

of Education, Grimes Building, Des Moines, Iowa. 
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PRESS RELEASE 

FOR IMMEDIATE RELEASE: 

Suecess4 INITIATIVE HELPS 
BUILD BEITER STUDENTS 

(CITY /COUNTY NAME), IA-- Mr./Ms (BOARD MEMBER NAME), (CITY /COUNTY 

NAME) School Board member, today announced the adoption of the new Success4 

integrated initiative for school improvement. According to (BOARD MEMBER 

NAME), the School Board is thrilled with the prospect of implementing the new 

process. 

The Success4 Initiative for school improvement is a process devised by a select 

committee of the Iowa Department of Education, Division of Early Childhood, 

Elementary and Secondary Education. It offers a systematic method of addressing 

specific educational needs of individual schools and communities. Success4 

addresses not only the intellectual skills of students, but their social, emotional and 

behavioral skills, as well. 

The mission of the Success4 school improvement initiative is to make Iowa a place 

where schools, families and communities work together to support the social, 

emotional, intellectual and behavioral development of all children and youth. 

1 



(BOARD MEMBER NAME) went on to explain, "This is the first time that the 

combined resources of such diverse groups as families, schools, communities, and 

the State of Iowa have been brought to bear on the problems and needs of 

individual schools. We start by assessing the needs of the families, local schools, and 

COIIJ.munity. Then we develop a plan to meet those needs, implement the plan, and 

evaluate our efforts. It is a very efficient, very effective process. We believe it will go 

a long way in producing better educated students who are emotionally well adapted 

and have the social skills to cope in today's complex society." 

If you would like more information about the Success4 School Improvement 

Initiative and how you can become involved, contact (BOARD MEMBER NAME) at 

(LOCAL PHONE NUMBER). If you would like to organize a Success4 initiative in 

your own community, contact the Iowa Department of Education, Grimes Building, 

Des Moines, Iowa. 
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